Abstract

The C099-F9P board enables customers to evaluate RTK operation with the ZED-F9P high precision GNSS receiver. The board provides short-range wireless connection via Bluetooth® or Wi-Fi for receiving correction data and logging via wireless connectivity.
Document Information

<table>
<thead>
<tr>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>C099-F9P</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Subtitle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Board (Rev. B), ODIN-W2 Connectivity SW</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Document type</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Guide</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Document number</th>
</tr>
</thead>
<tbody>
<tr>
<td>UBX-18055649</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Revision and date</th>
</tr>
</thead>
<tbody>
<tr>
<td>R04 21-Feb-2019</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Disclosure Restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public</td>
</tr>
</tbody>
</table>

This document applies to the following products:

<table>
<thead>
<tr>
<th>Product name</th>
<th>Type number</th>
<th>Firmware version</th>
<th>PCN reference</th>
<th>Product status</th>
</tr>
</thead>
<tbody>
<tr>
<td>C099-F9P</td>
<td>C099-F9P-0-01</td>
<td>HPG1.00, HPG 1.10, HPG 1.11</td>
<td>N/A</td>
<td>Engineering Sample</td>
</tr>
<tr>
<td></td>
<td>C099-F9P-1-01</td>
<td>Connectivity SW 5.0.1 or later</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>C099-F9P-2-01</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

u-blox or third parties may hold intellectual property rights in the products, names, logos and designs included in this document. Copying, reproduction, modification or disclosure to third parties of this document or any part thereof is only permitted with the express written permission of u-blox.

The information contained herein is provided “as is” and u-blox assumes no liability for its use. No warranty, either express or implied, is given, including but not limited to, with respect to the accuracy, correctness, reliability and fitness for a particular purpose of the information. This document may be revised by u-blox at any time without notice. For the most recent documents, visit www.u-blox.com.

Copyright © u-blox AG.
Contents

Document Information ....................................................................................................................................................... 2

Contents ........................................................................................................................................................................ 2

1 Introduction ........................................................................................................................................................................ 5
   1.1 Package contents ...................................................................................................................................................... 6
   1.2 Additional sources of information ............................................................................................................................ 6

2 C099-F9P quick start ...................................................................................................................................................... 7
   2.1 Starting up ............................................................................................................................................................... 7

3 C099-F9P description ..................................................................................................................................................... 9
   3.1 Component overview ................................................................................................................................................. 9
   3.2 Component identification ........................................................................................................................................... 9
       3.2.1 ZED-F9P status LEDs .................................................................................................................................. 11
       3.2.2 ODIN-W2 activity LED .................................................................................................................................. 12

4 Using the C099-F9P ................................................................................................................................................... 13
   4.1 Powering the board ................................................................................................................................................. 13
   4.2 GNSS RF input ......................................................................................................................................................... 14
   4.3 User interfaces ......................................................................................................................................................... 14
       4.3.1 FTDI USB bridge ............................................................................................................................................ 15
       4.3.2 Bluetooth serial COM port connection ....................................................................................................... 16
       4.3.3 Windows OS issues with Bluetooth SPP .................................................................................................. 18

5 Rover operation using NTRIP ...................................................................................................................................... 19
   5.1 PC hosting via u-center ........................................................................................................................................... 19
   5.2 Mobile hosting ......................................................................................................................................................... 20
   5.3 Pairing the host with the C099-F9P ....................................................................................................................... 20

6 Reference station and rover pairing ............................................................................................................................. 21
   6.1 Wi-Fi connection between two C099-F9P boards .................................................................................................. 21
       6.1.1 Configuring a C099-F9P rover for Wi-Fi operation .................................................................................. 21
       6.1.2 Configuring a C099-F9P reference station (Base) for Wi-Fi operation .................................................. 24
       6.1.3 ZED-F9P reference station (Base) and Rover configuration .................................................................. 25

7 Firmware updates ....................................................................................................................................................... 30
   7.1 ZED-F9P firmware update .................................................................................................................................. 30
   7.2 ODIN-W2 firmware update .................................................................................................................................. 30

8 Arduino header connections ........................................................................................................................................ 34

Appendix ...................................................................................................................................................................... 34

A Glossary ...................................................................................................................................................................... 34

B Resources ................................................................................................................................................................... 34

C u-blox ODIN-W2 BT Rover.txt ................................................................................................................................ 34

D Rover ODIN-W2 Access Point UDP Server.txt ..................................................................................................... 35

E Reference station ODIN-W2 UDP client.txt ........................................................................................................... 36

F F9P Base config C99.txt .......................................................................................................................................... 36

G F9P Rover config C99.txt ...................................................................................................................................... 37
H  C099-F9P antenna specification ................................................................................................... 37
  H.1  Wi-Fi/Bluetooth antenna specification .................................................................................. 37
  H.2  Multi-band GNSS antenna specification .............................................................................. 38
    H.2.1  Patch antenna element specification .............................................................................. 38
    H.2.2  LNA electrical specification ......................................................................................... 39
    H.2.3  Overall performance .................................................................................................. 39
I  Mechanical board dimensions ........................................................................................................ 40
J  C099-F9P schematics ....................................................................................................................... 41
Related documents ................................................................................................................................... 48
Revision history .......................................................................................................................................... 48
Contact .......................................................................................................................................................... 49
1 Introduction

The C099-F9P board is a convenient tool that allows customers to become familiar with the u-blox ZED-F9P high precision module performance. The board provides facilities for evaluating the product and demonstrating its key capabilities. The main components are:

- A ZED-F9P module for use as a RTK rover or reference station
- An ODIN-W2 short-range module to provide untethered operation using Wi-Fi or Bluetooth
- Power supply options comprising a USB connection, LiPo cell with recharging ability, and 6-17 V DC input
- Small and light board (110 x 55 mm) with Arduino R3/Uno shield connections for host expansion

This user manual describes the following use cases:

1. Base and Rover operation via serial connectivity
2. Base and Rover operation via Wi-Fi (with ODIN-W2 connectivity software)
3. Rover operation via Bluetooth Classic (with ODIN-W2 connectivity software)

The Guide is split into several sections:

- The Quick Start section provides information to get up and running straight out of the box.
- The C099-F9P Description identifies the board’s facilities.
- Using the C099-F9P provides a comprehensive guide for in-depth usage.
- Rover operation using NTRIP shows some different ways of connecting to a service.
- Reference station and rover pairing chapter details using two C099s as a Reference/Rover pair.
- The firmware updates section provides instructions for updating the firmware of the ZED-F9P high precision GNSS module as well as the ODIN-W2 short-range module.

---

1 The C099-F9P kit does not contain a battery or external power adapter.
1.1 Package contents

The delivered package contains:

- C099-F9P board (Rev. B)
- u-blox multi-band GNSS antenna and ground plane
- Wi-Fi/Bluetooth antenna
- USB interconnect cable

Figure 1: C099-F9P kit contents

1.2 Additional sources of information

Prior to using the board, it is useful to download the appropriate evaluation software and keep handy the following documents:

- ZED-F9P Integration Manual, Doc. No. UBX-18010802
- ZED-F9P Interface Description, Doc. No. UBX-18010854
2 C099-F9P quick start

This section provides some short steps to enable ZED-F9P operation before exploring the more complex configurations described later.

2.1 Starting up

- Connect the supplied multi-band GNSS antenna to the ZED-RF SMA connector. Ensure good signal reception.
- Connect the USB to a Windows 10 PC; this will power the board. The driver will be installed automatically from Windows Update when you connect the board for the first time.
- Start u-center and connect to the COM port identified as “C099 application board, ZED-F9P” using Device Manager. Set the baud rate to 460800 baud. See section 4.3.1 for detailed instructions.
- If everything is correctly installed, the receiver should begin operation in its default state. The Figure 4 below shows a typical u-center view with active satellite signal levels etc. The Time Pulse LED on the C099-F9P board will blink in blue color.

To operate the ZED-F9P in RTK more, the GNSS antenna must be placed in an open environment and the unit must be connected to a RTK correction service. Where available, the evaluation kit comes with a free trial of the SmartNet correction service. Consult the leaflet included with the kit for information on how to register for the service and how to obtain mount point and user connection details before moving to the next steps.

RTK corrections can be applied using a u-center built-in NTRIP client. To use the C099-F9P board with a correction service follow these next steps:

- In u-center, click on the Receiver Menu item
- Select “NTRIP Client…”
- Fill in the settings for the NTRIP caster, username and password
- Click “Update source table” and select the recommended NTRIP mount point
- Click OK to close the dialog and connect to the service
- In the Data View of u-center, the Fix Mode should change from “3D” to “3D/DGNSS” when RTCM corrections are received. The RTK LED will blink in green color.
- The status will change to “3D/DGNSS/FIXED” and the RTK LED will show a steady green color.
Figure 3: u-center showing a view of the ZED-F9P default operation
3  C099-F9P description

3.1 Component overview

The C099-F9P houses the ZED-F9P RTK high precision positioning module and an ODIN-W2 module for wireless short-range communications. An FTDI component provides dedicated COM port connections with the ZED-F9P and ODIN-W2 via a USB connector.

The board can be powered by USB, a DC supply socket, or from a LiPo (lithium polymer) battery. The board has been designed using an Arduino form factor with the modules’ serial ports routed to the shield headers.

The block diagram in Figure 4 shows the logical signal flow between the individual parts.

![Figure 4: C099-F9P block diagram](image)

3.2 Component identification

The following images show the position of major parts and user interfaces.

- Main components – Figure 5
- Switches and LEDs – Figure 6

The function of these are described later on in this section.
Figure 5: Main components and USB ports

- ZED-F9P Multi band GNSS RTK module
- ODIN-W2 Multi-radio module
- GNSS antenna connector
- Wi-Fi/BT antenna connector
- J2, J3, J8, J9 Arduino Uno connectors
- DC power jack
- Battery connector
- USB (ZED-F9P USB and UART, ODIN-W2 UART ports)
The MicroSD card slot is not used in this version of the board. The ODIN-W2 Switch 0 interrupt is not required for normal customer use.

3.2.1 ZED-F9P status LEDs

The board provides three LEDs to show the ZED-F9P status. The location of the LEDs is shown in Figure 7 below.

The RTK Status LED provides an indication of the state of the ZED-F9P module RTK-STAT pin.

- At start-up the LED is off.
- When in RTK Float mode, the yellow LED flashes at the navigation rate (1Hz default). This is also an indication that RTCM corrections are received
- When in RTK fixed mode, the yellow LED is turned on.

The Time Pulse blue LED will flash at the default 1Hz rate when the time solution is valid.

If activated, the Geofence status LED indicates the current Geofence status, i.e. in or outside a designated area.

See the ZED-F9P Interface Description [2] for help with configuring the Time Pulse output or activating the Geofence pin.
3.2.2 ODIN-W2 activity LED

The ODIN-W2 module uses a multi-colored LED to show particular activity status. This is positioned adjacent to the ZED-F9P reset switch and shown below in Figure 8. The activity status is summarized in Table 1 below.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Status</th>
<th>LED color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data mode, EDM</td>
<td>IDLE</td>
<td>Green</td>
</tr>
<tr>
<td>Command mode</td>
<td>IDLE</td>
<td>Orange</td>
</tr>
<tr>
<td>Data mode, Command mode, EDM</td>
<td>CONNECTING</td>
<td>Purple</td>
</tr>
<tr>
<td>Data mode, Command mode, EDM</td>
<td>CONNECTED(^2)</td>
<td>Blue</td>
</tr>
</tbody>
</table>

Table 1: ODIN-W2 connectivity software LED activity states and colors

\(^2\) On data activity, the active LED flashes.

Figure 8: ODIN-W2 Activity LED position on C099-F9P board
4 Using the C099-F9P

The ZED-F9P is shipped with the latest firmware. Information on updating either module’s firmware is provided in section 7, if required.

4.1 Powering the board

The board can be powered from a variety of sources:

- The USB connection
- A 3.7V LiPo Battery via a JST connector
- An external 6-17V DC source via a 2.1mm connector; center pin V+.

⚠ Follow all published safety advice for using bare cell LiPo batteries while charging and protecting them from mechanical damage. Fire risk can occur if the advice is not followed.

⚠ Ensure correct polarity on the JST battery connector to avoid reverse polarization on supply rails.

All supply connections are fed via a Schottky diode to the main supply bus to allow multiple sources to be connected in parallel. The LiPo battery will be charged from the USB connection. The charging status is indicated by a red LED which is on during charging and turned off when fully charged.
4.2 GNSS RF input

The C099-F9P board should be used with the antenna supplied with the kit. If another active antenna is used, be aware that the RF input has a bias output designed to supply 3.3V DC with a 70 mA maximum current load. A DC block is advisable if the board is connected to a signal distribution scheme or GNSS simulator to prevent any potential shorting of the antenna bias.

When using the supplied antenna it is advisable to use the ground plane provided. Otherwise ensure that there is an adequate ground plane, e.g. by mounting in the center of a metallic car roof.

4.3 User interfaces

The C099-F9P has a number of fixed connection options besides the wireless modes. There is also an additional Arduino R3 / Uno interface for external host connection.

The USB connector on the board provides connection via an on-board hub providing:

- An FTDI USB bridge to ZED-F9P UART1 and ODIN-W2 UART COM ports.
- Dedicated connection to the ZED-F9P USB port.
4.3.1 FTDI USB bridge

When the USB cable from the user's PC is connected, a driver will load and set up two virtual serial ports, as shown below in Figure 14. Additionally, a further serial VCP will be created to provide a direct connection with the ZED-F9P USB port.

Ensure that the PC is connected to the internet to load the drivers from Windows update.

The first of these is connected to the ZED-F9P serial port and should be selected with u-center. The second serial device is for the ODIN-W2 module when using s-center. In Figure 14 the ODIN-W2 connection is the first port (COM 62) and the ZED-F9P connection is the second port (COM 64). Port numbering can be different between individual PCs, but the same arrangement applies.

Figure 14: Windows device manager COM port view

In addition, a third VCP will be created corresponding to the ZED-F9P USB port. Windows 10 users will see a new VCP device in the device manager window as it will load an in-built driver. With older Windows installations a driver will be loaded via Windows update. In this case the device will be identified as a u-blox GNSS device in the Device Manager window.

Open u-center (V18.06 or later), select the ZED-F9P serial port, and set the baud rate to 460800 to match the ZED-F9P default UART setting. Once connected, u-center shows typical received signal levels from multiple GNSS bands, see Figure 15 below.

Additional UBX protocol messages can be enabled to view additional information in u-center. For example, the following are typical messages the user can poll or enable for periodic update.

- NAV-HPPOSLLH
- NAV-RELPOSNED
- NAV-SIG
- NAV-SOL
- NAV-STATUS
- NAV-SVIN

See section 5.2.6 Messages view in the u-center User Guide [3]
4.3.2 Bluetooth serial COM port connection

Before using Bluetooth or Wi-Fi ensure that the supplied Wi-Fi/Bluetooth antenna has been connected to the SMA connector “ODIN-RF” to ensure correct operation of the wireless functions.

The C099-F9P board is delivered with the ODIN-W2 pre-configured for connecting the ZED-F9P as a Bluetooth serial device. On a PC, go to the Bluetooth setup and add the ODIN-W2 module as a device, identified as “ODIN-W2-XXXX”. See Figure 16, Figure 17 below.

![Figure 16: Windows 7 add a device window shows ODIN-W2](image)

Users can locate the device by examining the Bluetooth connections under the Ports tab in the Windows device manager for a “Standard Serial over Bluetooth link” - usually the first one in the list. Use this device for connecting the ZED-F9P to u-center.

![Figure 17: Click on the ODIN-W2 and select Next](image)

![Figure 18: Installed Bluetooth SPP port](image)

The ODIN-W2 module communicates with the ZED-F9P via a serial port which is shared with the FTDI USB/COM port via multiplexors. Once Bluetooth communication is established with the ODIN-W2, a jumper connection should be made at position “3OE” to connect the serial ports of the ZED-F9P and ODIN-W2 together. See Figure 19 below.
For information, Figure 20 below shows the C099-F9P logical connections for serial interfaces with the “OE3” jumper set as required to connect the ODIN-W2 and ZED-F9P serial ports.

UART1 MODE:

Figure 20: Schematic showing serial interface connection with jumper OE3 setting
4.3.3 Windows OS issues with Bluetooth SPP

There are some known issues with the Windows Bluetooth Serial Port Profile (SPP) implementation for Windows 7-10. Symptoms include the Bluetooth Virtual COM port not installing or applications not connecting to the Bluetooth Virtual COM port. In other cases Windows might crash or become unresponsive. This is not related to the ODIN-W2 Bluetooth implementation that uses the Bluetooth standard SPP.

A known industry fix is to not use the Windows Bluetooth stack and PC Bluetooth hardware. This is done by using a USB Bluetooth adapter that uses its own Bluetooth stack. A device that is known to work is the ASUS USB-BT400 (USB 2.0). Once installed use the Bluetooth Virtual COM port assigned to this device and not the built-in Bluetooth.

![ASUS USB-BT400](image)

*Figure 21: ASUS USB-BT400*
5 Rover operation using NTRIP

This section shows how the ZED-F9P is used as a rover using correction information provided over the internet using NTRIP. This is usually provided by a host from a single reference station or as a Network RTK Virtual Reference Service (VRS).

Suitable hosts are a PC with internet access and/or an Android cellular phone with mobile data capability. The host runs an NTRIP client and streams RTCM corrections to the C099-F9P.

5.1 PC hosting via u-center

The u-center application includes an NTRIP client for PC hosting. The u-center user guide [3] provides help when setting NTRIP service connections. Users can connect via Bluetooth for wireless operation or directly via a serial COM port. Once the service is active, RTCM corrections are sent over the connection and data can be logged as usual with u-center.

☞ See the NTRIP section in the u-center User Guide [3].

Enter the required connection settings using the client setting window show below.

Figure 22: u-center NTRIP Client view

Ensure the NTRIP Client connection flag is green for successful connection and RTCM3 data transfer to the C099-F9P:

Figure 23: u-center NTRIP Client communication indicator
View that the Rover has obtained RTK Fixed mode in u-center data view:

![Figure 24: u-center Data view RTK FIXED indication](image)

5.2 Mobile hosting

A more portable option is to pair a mobile phone with the C099 and run an NTRIP application on the phone. The one shown below is by Lefebure which is available from the Google play store. It works with the C099 via Bluetooth, other similar applications exist as well.


![Figure 25: Lefebure Android NTRIP client](image)

5.3 Pairing the host with the C099-F9P

For both options the user needs to pair the host (PC or mobile) with the C099 ODIN-W2 wireless module.

Once paired the user can then attach the host application to the C099 to send and receive data.

☞ See Section 4.3.2 for pairing information.
6 Reference station and rover pairing

This section is provided for users with two C099 boards and provides configuration information when setting up a C099-F9P as a reference station to provide local RTCM corrections for a C099 rover. This connection uses Wi-Fi connectivity to maximize range for untethered operation.

6.1 Wi-Fi connection between two C099-F9P boards

This set-up relies on establishing a peer-to-peer Wi-Fi connection between two C099 boards for short base-line applications, e.g. drones and the like.

Separate ODIN-W2 configuration files are required to enable the reference station and rover C099 boards to operate as an Access Point and client respectively. Ensure the ODIN-W2 on the rover and reference station runs the u-blox connectivity software.

Prior to use, the reference station C099-F9P needs RTCM3 output messages enabled and its position surveyed-in. When the device is surveyed-in it will enable output of the RTCM3 1005 message to enable the rover to begin RTK operation. Consult the Integration manual [4] for information relating to reference station operation for more information.

In this example the C099 reference station sends corrections to a C099 rover and the rover transmits NMEA and UBX messages back to the base. The rover operation can be viewed remotely with u-center connected to the reference station’s ODIN-W2 COM port.

![Reference and rover C099-F9P set up.](image)

The sub-sections below describe the steps required to configure the boards for Wi-Fi operation plus the settings needed for rover and base operation.

6.1.1 Configuring a C099-F9P rover for Wi-Fi operation

The following steps provide guidance on configuring the C099 ODIN-W2 Wi-Fi for rover operation:

☞ Disconnect any UART multiplexor jumper connections before proceeding.

- Connect the rover unit via USB to a PC.
- Install the u-blox s-center evaluation application.
- Open s-center which will show the following view:
- Select the COM port installed for the ODIN-W2.
- Set the baud rate to 460800 baud.
- Ensure there is no hardware flow control enabled.
- Click on the FTDI USB Latency Timer Update button.
- Click Open Port.
- If the C099-F9P is powered the ODIN-W2 should respond with AT commands.

Figure 27: s-center connection setting window

Figure 28: s-center connected to ODIN-W2
It is important to do a factory reset on the ODIN-W2 before downloading a new configuration file. Click the Factory button to perform a factory reset.

Figure 29: s-center factory reset button

After factory reset, the device will be set with a baud rate of 115200 baud with hardware flow control enabled. This needs to be changed to no hardware flow control:

- First set s-center to 115200 baud and no flow control.
- Open the COM port
- Select “EVK-ODIN-W2 via ST-LINK” button as shown below to disable flow control.

Figure 30: Resetting ODIN-W2 to no flow control

Click the AT mode button to ensure it is responding correctly. You will see it respond with AT commands if communication is ok.

Figure 31: Clicking AT Mode button

Download the u-blox configuration file for the rover Wi-Fi link. Use the “Rover ODIN-W2 Access Point UDP Server.txt” file listed in Appendix D. The file can also be downloaded from Github: https://github.com/u-blox/ublox-C099_F9P-uCS/tree/master/odin-w2

Select "File > Download Configuration".
Figure 32: Selecting File > Download Configuration

Select the “Rover ODIN-W2 Access Point UDP Server.txt” file and click Open.

Figure 33: Selecting File “Rover ODIN-W2 Access Point UDP Server.txt”

Disconnect s-center from the ODIN-W2 port and toggle the C099-F9P off and on again to ensure it will be using the new configurations as default.

Position a jumper as shown in Figure 20 to connect the ZED-F9P and ODIN UARTs. This will enable correction traffic from the rover and provide a return path for messages from the rover.

Connect the GNSS antenna, ensure use with the supplied ground plane and place in good GNSS visibility conditions.

In order to prevent the ODIN-W2 from mistranslating NMEA and UBX streams, it is advised to reprogram the factory default escape sequence ‘+++’ as described in the AT Command Manual [5].

6.1.2 Configuring a C099-F9P reference station (Base) for Wi-Fi operation

The following steps describe setting up the C099 ODIN-W2 Wi-Fi for reference station operation.

Disconnect any jumper connections before proceeding.

Follow the same process for configuration described above in section 6.1.1 except load the reference station configuration file “Base ODIN-W2 Station UDP client.txt” instead - see Appendix D for the file listing.

After this the C099 reference station will require setting up as shown below to enable sending correction data to the rover.
6.1.3 ZED-F9P reference station (Base) and Rover configuration

With u-center V18.11 or later connect to the C099-F9P using the dedicated ZED-F9P USB connection. See section 3.5.2 – “Required configuration of the base and rover” in the ZED-F9P Integration Manual [4] for details on configuring the required RTCM3 messages and setting the ZED-F9P as a reference station. We provide easy-to-use configuration files to download, as detailed in the next section.

☞ Ensure all RTCM messages are set to transmit from UART1 and the baud rate is set to 460800, otherwise the ZED-F9P and ODIN-W2 cannot communicate. Wrong settings can occur if the ZED-F9P firmware is updated or the ZED-F9P UART1 is set to its default state.

☞ Ensure that the UART1 port protocols are set to “None” for input and “RTCM3” for output to prevent input of the received rover messages.

☞ Place a jumper at position “OE3” as shown in Figure 19, this will connect the ODIN-W2 and ZED-F9P UARTs to provide transmission of RTCM messages to the rover.

6.1.3.1 Downloading Base ZED-F9P configuration file

Download the configuration files from: https://github.com/u-blox/ublox-C099_F9P-uCS

Or save the contents of Appendix F to a txt file. Open u-center View/Generation 9 Configuration View:

Figure 34: u-center View/Generation 9 Configuration View

Now select Advanced Configuration:

Figure 35: u-center View/Generation 9 Configuration View/Advanced Configuration
Important next step – return receiver to defaults:

![Figure 36: Return receiver to defaults and select 38400 baud](image)

Now select/load the “F9P Base config C99.txt” file and Send the configuration:

![Figure 37: Load F9P Base config C99.txt file and Send](image)

Keep the USB connected to the PC, however disconnect u-center from the ZED-F9P USB port and connect to the ODIN-W2 USB Virtual Com Port. This will allow viewing and logging of the rover C099-F9P message data via the return Wi-Fi link.

Connect the GNSS antenna, ensuring use with the supplied ground plane and place in good GNSS visibility conditions.

Now load the “F9P Base Survey in start.txt” file in the same way, except do not return the receiver to default settings, as we have a working configuration. It should carry out the Survey-In process and then output all the required RTCM messages.

### 6.1.3.2 Downloading Rover ZED-F9P configuration file

Connect the Rover ZED-F9P via the dedicated USB connection.

Load and Send the “F9P Rover config C99.txt” file as shown in the previous section. Both units will now be ready to operate. You would have previously downloaded it from the u-blox GITHUB repository. Or copy the contents of Appendix G to a txt file.
A Wi-Fi connection is established between reference and rover boards when the rover C099-F9P is powered up. The ODIN-W2 activity LED is set blue when the base and rover have connected and flashes when data transfer is occurring. Look for acquisition activity shown in u-center to confirm the rover is operating correctly.

⚠ Ensure that any rover ZED-F9P output messages and configurations required are set before connecting the reference as this can only be done via the dedicated ZED-F9P USB connection. Ensure that the configuration is saved to Flash to avoid reverting to default operation after power cycling.

u-center will now show the rover GNSS information via the reference C099-F9P ODIN-W2 connection:

![Figure 38: u-center satellite signal view](image)

Check that the rover has obtained a RTK Fixed mode in u-center Data view:

![Figure 39: u-center Data view RTK FIXED indication](image)
7 Firmware updates

This section shows how to update the GNSS and Wi-Fi/Bluetooth modules’ firmware if required.

The board is delivered with the latest versions of firmware running on the ZED-F9P and ODIN-W2 modules. However, newer versions may become available during the lifetime of the product.

7.1 ZED-F9P firmware update

This section shows how to update the firmware and re-enable the configuration settings required for the C099-F9P.

To update the ZED-F9P, connect via USB to the COM port identified as the ZED-F9P to u-center and poll MON-VER to view the installed firmware: see Figure 14 for the Device Manger COM port view. The shipped units will have HPG1.00 firmware or newer. To download a new firmware follow the sequence detailed below.

![Figure 40: MON-VER poll response](image)

To begin updating the firmware, select “Tools > Firmware Update…”

![Figure 41: Selecting u-center Firmware Update mode](image)

The Firmware Update Utility window will appear as shown below:
Figure 42: Selecting u-center Firmware image folder

At the top is the firmware image file selection window. Click on the button to the right of the window. This allows you to select the folder and file. Select the new firmware image bin file.

Set the “Enter safeboot before update” and “Send training sequence” options. Set the “Use this baudrate for update” option and select e.g. 460800 from the pull-down list. This is shown in Figure 42 below.

Figure 43: Setting the required baud rate, Safeboot and Training sequence options

Then click the GO button at the bottom left corner of the window to begin the download.

Figure 44: Click GO for firmware update

The firmware update progress indication is shown adjacent to the input window.
When programming is complete, the module will start up in a default configuration in which the ZED-F9P serial port is set to 38400 baud. This requires changing to 460800 baud to provide sufficient data bandwidth and work correctly with the ODIN-W2 module.

This can be done using ublox 9 new configuration file download. This allow quick easy setting up of the ZED-F9P Base and Rover. Proceed to section 6.1.3 for further steps.

7.2 ODIN-W2 firmware update

Latest u-blox connectivity software and related documentation is available via u-blox.com:


It is recommended to download the stm32flash.exe command line tool from STM website or from Sourceforge:

https://sourceforge.net/projects/stm32flash/

The software upload procedure consists of two consecutive phases. Firstly, a bootloader is required to be uploaded. Prior to bootloader upload, the ODIN-W2 must be restarted in safe boot mode. Proceed by placing a safe boot jumper and reboot the C099-F9P. The location of the safe boot pin header and the reset button is depicted in Figure 6. Continue with the bootloader upload:

```
./stm32flash.exe -b 115200 -w <ODIN-W2-BOOT.bin> -S 0x8000000 COM<port number>
```

The actual connectivity software shall be uploaded while the ODIN-W2 is still in safe boot mode. Ensure correct memory indexing by incrementing the memory argument as shown below:

```
./stm32flash.exe -b 115200 -w <ODIN-W26X-SW.bin> -S 0x8010000 COM<port number>
```

Once the connectivity software is uploaded successfully, UART baud rate of ODIN-W2 needs to be set to 460800 to ensure sufficient link bandwidth. To proceed, restart the ODIN-W2 in a normal boot mode by removing the safe boot jumper and pressing the RESET button. Follow-up by connecting s-center to C099-F9P and navigate to "User Defined" AT command tab, as depicted in Figure 47.
Execute the following command set sequentially:

- `AT+UMRS=460800,2,8,1,1,0`
- `AT&W`
- `AT+CPWROFF`

Finally, adjust s-center baud rate to match 460800 by closing and opening the UART port.

**Figure 46: Set baud rate**

Click the AT mode button to ensure it is responding correctly. You will see it respond with AT commands if communication is ok.

**Figure 47: Clicking AT Mode button**
Download a u-blox configuration file for the ODIN-W2 module. The “u-blox ODIN-W2 BT Rover.txt” file is the default configuration file shipped with the C099. See Appendix B for configuration file resources.

![Selecting File > Download Configuration](image)

**Figure 48: Selecting File > Download Configuration**

![Selecting u-blox ODIN-W2 BT Rover.txt file](image)

**Figure 49: Selecting u-blox ODIN-W2 BT Rover.txt file**

Select the file and click Open. It will download the file and write it to Flash.

✈️ The ODIN-W2 UART will now be set to 460800 baud in Data default mode. It will be ready for use again.

Disconnect s-center from the ODIN-W2 port and power the C099-F9P off and on to ensure it will be using the new configurations as default.

Position a jumper at “OE3” for Bluetooth operation.

The rover is now ready to connect to PC or Mobile via Bluetooth SPP.

The board is now ready to use for the wireless connection examples described in the earlier sections.

When untethered operation is not required, the ZED-F9P dedicated USB connection on the C099 can be used for supplying corrections and monitoring/logging purposes with u-center.
8 Arduino header connections

The board size and four connectors comply with the Arduino R3/Uno mechanical specification. The functions of each I/O align as much as possible to the Arduino specified functions. Check the pin functions before using with an Arduino R3/Uno; see Figure 23 below. All the pin functions besides power are 3.3V compliant.

Figure 50: C099-F9P Arduino connectors

Figure 51 C099-F9P Arduino R3 connections
Appendix

A Glossary

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LiPo</td>
<td>Lithium Polymer</td>
</tr>
<tr>
<td>NTRIP</td>
<td>Networked Transport of RTCM via Internet Protocol</td>
</tr>
<tr>
<td>RTK</td>
<td>Real Time Kinematic</td>
</tr>
<tr>
<td>UART</td>
<td>Universal Asynchronous Receiver Transmitter</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>UTC</td>
<td>Coordinated Universal Time</td>
</tr>
<tr>
<td>VCP</td>
<td>Virtual Com Port</td>
</tr>
</tbody>
</table>

Table 2: Explanation of the abbreviations and terms used

B Resources

Applicable configuration files are available via u-blox Github:

https://github.com/u-blox/ublox-C099_F9P-uCS

C u-blox ODIN-W2 BT Rover.txt

Copy all the text below this line into a text file named “u-blox ODIN-W2 BT Rover.txt”.

AT+UBTLN="ODIN-W2-xxxx"
AT+UBTLC=000000
AT+UBTCM=2
AT+UBTDM=3
AT+UBTPM=2
AT+UBMTSP=1
AT+UBLTLE=0
AT+UBTSM=1
AT+UNHN="ODIN-W2-20003600155137333393539"
AT+UDDRP=0,"",0
AT+UDDRP=1,"",0
AT+UDDRP=2,"",0
AT+UDDRP=3,"",0
AT+UDDRP=4,"",0
AT+UDDRP=5,"",0
AT+UDDRP=6,"",0
AT+UWSC=0,4
AT+UWSC=0,0,0
AT+UWAPC=0,4
AT+UWAPC=0,0,0
AT+UWAPC=0,2,""
AT+UWAPC=0,4,1
AT+UWAPC=0,5,2,2
AT+UWAPC=0,100,1
AT+UWAPC=0,106,1
AT+UWSC=0,0,0
ATS2=43
ATS3=13
ATS4=10
ATS5=8
AT+UDCFG=0,1
AT&S1
AT&D0
ATE1
D Rover ODIN-W2 Access Point UDP Server.txt

Copy all the text below this line into a text file named “Rover ODIN-W2 Access Point UDP Server .txt”.

AT+UWAPCA=0,4
AT+UWAPC=0,0,1
AT+UWAPC=0,2,UBXWiffi
AT+UWAPC=0,4,1
AT+UWAPC=0,5,1,1
AT+UWAPC=0,100,1
AT+UWAPC=0,101,192.168.0.10
AT+UWAPC=0,102,255.255.0.0
AT+UWAPC=0,103,192.168.0.1
AT+UWAPC=0,104,0.0.0.0
AT+UWAPC=0,105,0.0.0.0
AT+UWAPC=0,106,1
AT+UWAPCA=0,1
AT+UWAPC=0,3
AT+UWCFG=1,0
AT+UDSC=1,2,5003,1
AT+UMSM=1
AT+UMRS=460800,2,8,1,1,1
AT&D
AT&W
AT+CPWROFF
**E Reference station ODIN-W2 UDP client.txt**

Copy all the text below this line into a text file named “Base ODIN-W2 Station UDP client.txt”.

```
AT+UWSCA=0,4
AT+UWSC=0,0,1
AT+UWSC=0,2,"UBXWifi"
AT+UWSC=0,5,1
AT+UWSC=1,0
AT+UWWCA=1
AT+ESSM=1
AT+UDDRP=0,"udp://192.168.0.10:5003",2
AT+UMSR=460800,2,8,1,1,0
AT&D0
AT&W
```

**F F9P Base config C99.txt**

Copy all the text below this line into a text file named “F9P Base config C99.txt”

```
# Config changes format version 1.0
# created by u-center version 18.11 at 11:37:53 on Tuesday, 08 Jan 2019
[del]
[set]
  RAM CFG-UART1INPROT-NMEA 0  # write value 0       to item id 10730002
  Flash CFG-UART1INPROT-NMEA 0  # write value 0      to item id 10730002
  RAM CFG-UART1INPROT-RTCM3X 0  # write value 0      to item id 10730004
  Flash CFG-UART1INPROT-RTCM3X 0  # write value 0     to item id 10730004
  RAM CFG-UART1OUTPROT-UBX 0   # write value 0       to item id 10740001
  Flash CFG-UART1OUTPROT-UBX 0   # write value 0      to item id 10740001
  RAM CFG-UART1OUTPROT-NMEA 0  # write value 0       to item id 10740002
  Flash CFG-UART1OUTPROT-NMEA 0  # write value 0      to item id 10740002
  RAM CFG-UART1OUTPROT-RTCM3X 1  # write value 1      to item id 10740004
  Flash CFG-UART1OUTPROT-RTCM3X 1  # write value 1     to item id 10740004
  RAM CFG-UART1INPROT-UBX 0   # write value 0       to item id 10730001
  Flash CFG-UART1INPROT-UBX 0   # write value 0      to item id 10730001
  RAM CFG-MSGOUT-RTCM_3X_TYPE1005_UART1 0x1  # write value 1 0x1   to item id 209102be
  Flash CFG-MSGOUT-RTCM_3X_TYPE1005_UART1 0x1  # write value 1 0x1   to item id 209102be
  RAM CFG-MSGOUT-RTCM_3X_TYPE1005_UART1 0x1  # write value 1 0x1   to item id 2091035f
  Flash CFG-MSGOUT-RTCM_3X_TYPE1005_UART1 0x1  # write value 1 0x1   to item id 2091035f
  RAM CFG-MSGOUT-RTCM_3X_TYPE1005_UART1 0x1  # write value 1 0x1   to item id 20910364
  Flash CFG-MSGOUT-RTCM_3X_TYPE1005_UART1 0x1  # write value 1 0x1   to item id 20910364
  RAM CFG-MSGOUT-RTCM_3X_TYPE1005_UART1 0x1  # write value 1 0x1   to item id 2091036e
  Flash CFG-MSGOUT-RTCM_3X_TYPE1005_UART1 0x1  # write value 1 0x1   to item id 2091036e
  RAM CFG-MSGOUT-RTCM_3X_TYPE1230_UART1 0x5  # write value 5 0x5   to item id 20910304
  Flash CFG-MSGOUT-RTCM_3X_TYPE1230_UART1 0x5  # write value 5 0x5   to item id 20910304
  RAM CFG-MSGOUT-RTCM_3X_TYPE1230_UART1 0x5  # write value 5 0x5   to item id 20910304
  Flash CFG-MSGOUT-RTCM_3X_TYPE1230_UART1 0x5  # write value 5 0x5   to item id 20910304
  RAM CFG-MSGOUT-RTCM_3X_TYPE1074_USB 0x1  # write value 1 0x1   to item id 209102c0
  Flash CFG-MSGOUT-RTCM_3X_TYPE1074_USB 0x1  # write value 1 0x1   to item id 209102c0
  RAM CFG-MSGOUT-RTCM_3X_TYPE1074_USB 0x1  # write value 1 0x1   to item id 20910361
  Flash CFG-MSGOUT-RTCM_3X_TYPE1074_USB 0x1  # write value 1 0x1   to item id 20910361
  RAM CFG-MSGOUT-RTCM_3X_TYPE1074_USB 0x1  # write value 1 0x1   to item id 20910366
  Flash CFG-MSGOUT-RTCM_3X_TYPE1074_USB 0x1  # write value 1 0x1   to item id 20910366
  RAM CFG-MSGOUT-RTCM_3X_TYPE1074_USB 0x1  # write value 1 0x1   to item id 20910370
  Flash CFG-MSGOUT-RTCM_3X_TYPE1074_USB 0x1  # write value 1 0x1   to item id 20910370
  RAM CFG-MSGOUT-RTCM_3X_TYPE1074_USB 0x1  # write value 1 0x1   to item id 20910370
  Flash CFG-MSGOUT-RTCM_3X_TYPE1074_USB 0x1  # write value 1 0x1   to item id 20910370
  RAM CFG-MSGOUT-RTCM_3X_TYPE1124_USB 0x1  # write value 1 0x1   to item id 20910369
  Flash CFG-MSGOUT-RTCM_3X_TYPE1124_USB 0x1  # write value 1 0x1   to item id 20910369
  RAM CFG-MSGOUT-RTCM_3X_TYPE1124_USB 0x1  # write value 1 0x1   to item id 20910369
  Flash CFG-MSGOUT-RTCM_3X_TYPE1124_USB 0x1  # write value 1 0x1   to item id 20910369
```
G F9P Rover config C99.txt

Copy all the text below this line into a text file named “F9P Rover config C99.txt

# Config changes format version 1.0
# created by u-center version 18.11 at 11:16:51 on Tuesday, 27 Nov 2018

[del]
[set]

RAM CFG-UART1INPROT-UBX 1 # write value 1 to item id 10730001
Flash CFG-UART1INPROT-UBX 1 # write value 1 to item id 10730001
RAM CFG-UART1INPROT-NMEA 0 # write value 0 to item id 10730002
Flash CFG-UART1INPROT-NMEA 0 # write value 0 to item id 10730002
RAM CFG-UART1INPROT-RTCM3X 1 # write value 1 to item id 10730004
Flash CFG-UART1INPROT-RTCM3X 1 # write value 1 to item id 10730004
RAM CFG-UART1OUTPROT-UBX 1 # write value 1 to item id 10740001
Flash CFG-UART1OUTPROT-UBX 1 # write value 1 to item id 10740001
RAM CFG-UART1OUTPROT-NMEA 1 # write value 1 to item id 10740002
Flash CFG-UART1OUTPROT-NMEA 1 # write value 1 to item id 10740002
RAM CFG-UART1OUTPROT-RTCM3X 0 # write value 0 to item id 10740004
Flash CFG-UART1OUTPROT-RTCM3X 0 # write value 0 to item id 10740004
RAM CFG-USBINPROT-UBX 1 # write value 1 to item id 10770001
Flash CFG-USBINPROT-UBX 1 # write value 1 to item id 10770001
RAM CFG-USBINPROT-NMEA 1 # write value 1 to item id 10770002
Flash CFG-USBINPROT-NMEA 1 # write value 1 to item id 10770002
RAM CFG-USBINPROT-RTCM3X 1 # write value 1 to item id 10770004
Flash CFG-USBINPROT-RTCM3X 1 # write value 1 to item id 10770004
RAM CFG-USBOUTPROT-UBX 1 # write value 1 to item id 10780001
Flash CFG-USBOUTPROT-UBX 1 # write value 1 to item id 10780001
RAM CFG-USBOUTPROT-NMEA 1 # write value 1 to item id 10780002
Flash CFG-USBOUTPROT-NMEA 1 # write value 1 to item id 10780002
RAM CFG-USBOUTPROT-RTCM3X 0 # write value 0 to item id 10780004
Flash CFG-USBOUTPROT-RTCM3X 0 # write value 0 to item id 10780004
Flash CFG-UART1-BAUDRATE 0x70800 # write value 460800 to item id 40520001
RAM CFG-UART1-BAUDRATE 0x70800 # write value 460800 to item id 40520001

H C099-F9P antenna specification

H.1 Wi-Fi/Bluetooth antenna specification

<table>
<thead>
<tr>
<th>EX-IT WLAN RPSMA / Ex-IT WLAN SMA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Polarization</td>
</tr>
<tr>
<td>Gain</td>
</tr>
<tr>
<td>Impedance</td>
</tr>
<tr>
<td>Size</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Connector</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Comment</td>
</tr>
<tr>
<td>Approval</td>
</tr>
</tbody>
</table>

Table 3: Wi-Fi/Bluetooth antenna
The variant included in the C099-F9P kit is with SMA connector and has to be mounted on the corresponding antenna connector of the C099-F9P board if you wish to use Wi-Fi or Bluetooth connectivity.

H.2 Multi-band GNSS antenna specification

This section details the u-blox multi-band GNSS antenna specification and performance on the required ground plane.

![Image of u-blox dual band GNSS antenna](image)

Figure 52: u-blox dual band GNSS antenna

H.2.1 Patch antenna element specification

<table>
<thead>
<tr>
<th>No</th>
<th>Item</th>
<th>Spec.</th>
<th>Unit</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>L1 Band</td>
<td>L2 Band</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Frequency</td>
<td>1559.0~1606.0</td>
<td>1197.0~1249.0</td>
<td>MHz</td>
</tr>
<tr>
<td>2</td>
<td>Polarization</td>
<td>RHCP</td>
<td>RHCP</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>Gain @ Zenith</td>
<td>Typ. 3.5</td>
<td>0~2.0</td>
<td>dBc</td>
</tr>
<tr>
<td>4</td>
<td>Axial Ratio</td>
<td>Max. 2.0 @Zenith</td>
<td>Max. 2.0 @Zenith</td>
<td>dB</td>
</tr>
<tr>
<td>5</td>
<td>Bandwidth @ -10dB</td>
<td>200 min.</td>
<td>200 min.</td>
<td>MHz</td>
</tr>
<tr>
<td>6</td>
<td>Impedance</td>
<td>50</td>
<td></td>
<td>ohm</td>
</tr>
<tr>
<td>7</td>
<td>Patch antenna size</td>
<td>Ø42–14T</td>
<td></td>
<td>mm</td>
</tr>
</tbody>
</table>

Note: 1) Measured on the 1500 mm ground plane

![Image of Patch elements specification](image)

Figure 53: Patch elements specification
### H.2.2 LNA electrical specification

<table>
<thead>
<tr>
<th>No</th>
<th>Item</th>
<th>Spec.</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>L1 Band</td>
<td>L2 Band</td>
</tr>
<tr>
<td>1</td>
<td>Frequency</td>
<td>1559.0~1606.0</td>
<td>1197.0~1249.0</td>
</tr>
<tr>
<td>2</td>
<td>Gain</td>
<td>28.0 ± 3.0 @5V</td>
<td>28.0 ± 3.0 @5V</td>
</tr>
<tr>
<td>3</td>
<td>Noise Figure</td>
<td>Max. 2.7 @5V</td>
<td>Max. 3.2 @5V</td>
</tr>
<tr>
<td>4</td>
<td>Output VSWR</td>
<td>Max. 2.0 : 1</td>
<td>Max. 2.0 : 1</td>
</tr>
<tr>
<td>5</td>
<td>Voltage</td>
<td>DC 3.0~5.0</td>
<td>V</td>
</tr>
<tr>
<td>6</td>
<td>Current</td>
<td>16.0 Typ. @ 5.0V</td>
<td>mA</td>
</tr>
<tr>
<td>7</td>
<td>Impedance</td>
<td>50</td>
<td>ohm</td>
</tr>
</tbody>
</table>

Figure 54: LNA specification

### H.2.3 Overall performance

<table>
<thead>
<tr>
<th>No</th>
<th>Item</th>
<th>Spec.</th>
<th>Unit</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>L1 Band</td>
<td>L2 Band</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Frequency</td>
<td>1559.0~1606.0</td>
<td>1197.0~1249.0</td>
<td>MHz</td>
</tr>
<tr>
<td>2</td>
<td>Total System Zenith Gain</td>
<td>25~26</td>
<td>24~27</td>
<td>dBic</td>
</tr>
<tr>
<td>3</td>
<td>Axial Ratio</td>
<td>Max. 2.0 @Zenith</td>
<td>Max. 2.0 @Zenith</td>
<td>dB</td>
</tr>
<tr>
<td>4</td>
<td>Output VSWR</td>
<td>Max. 2.0 : 1</td>
<td>Max. 2.0 : 1</td>
<td>-</td>
</tr>
<tr>
<td>5</td>
<td>Output Impedance</td>
<td>50</td>
<td>ohm</td>
<td></td>
</tr>
</tbody>
</table>

Note 2) Measured on the 1500 mm ground plane, DC 5V, 5m cable.

Figure 55: u-blox multi-band GNSS antenna performance
I Mechanical board dimensions

Figure 56: C099-F9P rev. B dimensions
J C099-F9P schematics

The following pages show the complete schematic for the C099-F9P evaluation board.
Related documents


☞ For regular updates to u-blox documentation and to receive product change notifications, register on our homepage (www.u-blox.com).

Revision history

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>R01</td>
<td>10-Jul-2018</td>
<td>ghun/ byou</td>
<td>Initial release.</td>
</tr>
<tr>
<td>R03</td>
<td>09-Jan-2019</td>
<td>olep</td>
<td>Updates for FW upload procedure for ODIN-W2.</td>
</tr>
</tbody>
</table>
Contact
For complete contact information, visit us at www.u-blox.com.

u-blox Offices

North, Central and South America
u-blox America, Inc.
Phone: +1 703 483 3180
E-mail: info_us@u-blox.com
Regional Office West Coast:
Phone: +1 408 573 3640
E-mail: info_us@u-blox.com
Technical Support:
Phone: +1 703 483 3185
E-mail: support@u-blox.com

Headquarters
Europe, Middle East, Africa
u-blox AG
Phone: +41 44 722 74 44
E-mail: info@u-blox.com
Support: support@u-blox.com

Asia, Australia, Pacific
u-blox Singapore Pte. Ltd.
Phone: +65 6734 3811
E-mail: info_ap@u-blox.com
Support: support_ap@u-blox.com
Regional Office Australia:
Phone: +61 2 8448 2016
E-mail: info_anz@u-blox.com
Support: support_ap@u-blox.com
Regional Office China (Beijing):
Phone: +86 10 68 133 545
E-mail: info_cn@u-blox.com
Support: support_cn@u-blox.com
Regional Office China (Chongqing):
Phone: +86 23 6815 1588
E-mail: info_cn@u-blox.com
Support: support_cn@u-blox.com
Regional Office China (Shanghai):
Phone: +86 21 6090 4832
E-mail: info_cn@u-blox.com
Support: support_cn@u-blox.com
Regional Office China (Shenzhen):
Phone: +86 755 8627 1083
E-mail: info_cn@u-blox.com
Support: support_cn@u-blox.com
Regional Office India:
Phone: +91 80 405 092 00
E-mail: info_in@u-blox.com
Support: support_in@u-blox.com
Regional Office Japan (Osaka):
Phone: +81 6 6941 3660
E-mail: info_jp@u-blox.com
Support: support jp@u-blox.com
Regional Office Japan (Tokyo):
Phone: +81 3 5775 3850
E-mail: info_jp@u-blox.com
Support: support jp@u-blox.com
Regional Office Korea:
Phone: +82 2 542 0861
E-mail: info_kr@u-blox.com
Support: support kr@u-blox.com
Regional Office Taiwan:
Phone: +886 2 2657 1090
E-mail: info_tw@u-blox.com
Support: support_tw@u-blox.com